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CLASS IX – COMPUTER SCIENCE 
MICROSOFT WORD – PAGE SETUP 

 
Section A: Theoretical Questions 

 

1. What is page layout in Microsoft Word? 
Answer: Page layout is the term used to describe how each page of your document will appear when 
it is printed. In Microsoft Word, page layout includes elements such as the Themes, Page Setup, Page 
Background, Paragraph setting etc. 
 

2. How many types of Page orientation are there in Microsoft Word? Name them and list the 
differences. 
Answer: There are two types of Page orientation in Microsoft Word: Portrait and Landscape. The 
following are the differences: 
 

Portrait Landscape 
A portrait orientation means a vertical 
display. 

A landscape orientation means a horizontal 
display. 

A portrait page or image is taller in height 
but narrower in width (height > width). 

A landscaped page, image, or painting is shorter 
in height but wider in width (width > height). 

Usually preferred for documents as it is 
useful to see a maximum number of lines of 
text. 

Useful for portraying wider visuals with multiple 
elements that need to be observed 
simultaneously. 

 
3. What do you mean by margin setting in Microsoft Word file? 

Answer: Page margins are the blank space around the edges of the page (Top, Bottom, Left, and 
Right) in general, you can insert text and graphics in the printable area between the margins. 
However, you can position some items in the margins — for example, headers, footers, and page 
numbers. 
 

4. What is gutter margin in Microsoft Word and how is it useful? How to set gutter margin? 
Answer: A gutter margin adds extra space to the side margin, top margin, or inside margins of a 
document that you plan to bind. A gutter margin helps ensure that text isn't obscured by the binding. 
 
To set gutter margin go to Custom Margins under Margins in Layout Tab. 
 

5. What do you mean by Header and Footer in Microsoft Word?  
Answer: A header is text that is placed at the top of a page, while a footer is placed at the bottom, 
or foot, of a page. Typically, these areas are used for inserting document information, such as the 
name of the document, the chapter heading, page numbers, creation date and the like. 
 

6. How can we insert Header and Footer in a Microsoft Word document? 
Answer: Header and Footer can be inserted in following ways: 

• Go to Insert Tab and Click on Header or Footer and choose the best option according to the 
need of the document. 

• The other way is to double click on top of document for header and bottom for footer and 
use the space for typing the text as required for the document. 

 
7. What do you mean by Paper Size in Microsoft Word? Name few standard papers and their sizes. 

Answer: Page size refers to the area of your Paper or sheet, size is the size of the paper used for 
printing. 
 
The following paper sizes are most commonly used: 

• A4 – 8.27” X 11.69” 
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• Letter – 8.5” X 11” 
• Legal – 8.5” X 14” 

 
8. What is Page Source in a Microsoft Word document? 

Answer: If printer supports multiple paper sources, to change the paper source used for document. 
For instance, you have a bin (also called as printer tray) that contains letterhead, and you want to 
print on it, the paper source should be selected accordingly.  
 
You can specify which paper tray you want used for the first page of your document, as well as all 
subsequent pages (Other Pages). For instance, first page is printed on letter head and rest pages on 
plain paper, so tray can be specified accordingly. 
 

9. Explain in brief the following with respect to page layout of Microsoft Word document. 
a. Mirror margin b. 2 pages per sheet c. Book fold 
Answer: 
a. Mirror margins are great for documents with facing pages, like bound reports or newsletters. 

This setting makes outside and inside margins identical. Outside margins are the left margin on 
the left page and the right margin on the right page. Inside margins are in between the two facing 
pages. Documents with facing pages may also have a gutter, which is a part of the page that is 
hidden when the document is bound. 

b. 2 pages per sheet prints two pages on a single side of the paper. If you’ve defined headers and 
footers, they’ll show up on both pages. Usually, you cut these pages after printing to create 
separate pages. 

c. Book fold is similar to the option above and prints two pages on one side of the paper. The 
difference is that the book fold layout is designed so you can fold the paper down the middle to 
create a booklet with facing pages. 

 
10. What is Section Break in Microsoft Word?  

Answer: Section breaks are used to divide the document into sections. Once section breaks are 
inserted, you can format each section separately. For example, format a section as a single column 
for the introduction of a report, and then format the next section as two columns for the report’s 
body text. 
 

11. Explain in brief the following section breaks of Microsoft Word document. How to insert these 
section breaks? 
a. Next Page b. Continuous c. Even Page/Odd Page 
Answer: 
a. Next Page – This section break starts the new section on next page. 
b. Continuous - This section break starts the new section on same page. 
c. Even Page – This section break starts the new section on next even-numbered page. 

Odd Page – This section break starts the new section on next odd-numbered page. 
 

 To insert these section breaks, go to layout tab, then click on breaks, then select the appropriate 
break under ‘Section Breaks’. 
 

12. What is Page Break in Microsoft Word? 
Answer: Microsoft Word automatically manages when text flows to a new page in a document. The 
user can also manually choose where a new page starts. A page break is a special marker that will 
end the current page and start new one. Once the page break is inserted, anything in document that 
is to the right or below the page break will move to new page. 
 

13. Explain in brief the following section breaks of Microsoft Word document. How to insert these 
section breaks? 
a. Page break b. Column break c. Text Wrapping break 
Answer: 
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a. Page Break – Mark the point at which one page ends and next page begins. 
b. Column Break – indicate the text following the column break will begin in the next column. 
c. Text Wrapping Break – Separate text around objects on web pages, such as caption text from 

body text.  
 

To insert these section breaks, go to layout tab, then click on breaks, then select the appropriate 
break under ‘Page Breaks’. 

 
14. With reference to Header and Footer in Microsoft Word document, explain in brief the following. 

How to use these features. 
a. Different First Page b. Different Odd & Even Pages 
Answer: 
a. Different First Page – Using a Different First Page lets you format cover and title pages 

differently from the rest of the document, such as headers or footers without text or page 
numbers. Different first page can be applied to the first page of any section in your document, 
not just the very first page. 

b. Different Odd and Even Pages – Specify that odd numbered pages have different header and 
footer from even numbered page. 

 
To use the above two features, double click on header or footer area of the document and then 
select any of these features. 
 

15. With reference to Page Setup, what are Line Numbers in Microsoft Word. Explain in brief it’s use. 
How can a user use this feature? 
Answer: Using Line Number feature, Microsoft Word can automatically count the lines in a document 
and display the appropriate number beside each line of text. This is useful when you need to refer 
to specific lines in a document, such as a script or a legal contract. 
 
To view line numbers, go to Layout tab and select Line Numbers and then select appropriate option. 
 

16. What is the difference between Paper Size and Page Margins in Word? 
Answer: Paper Size refers to the size of the paper you will be printing your document on. Page 
Margins refer to the outside area of a page that can be made bigger or smaller to fit content. 

 
 

Section B: Multiple Choice Questions 
 
Correct answer indicated in green font and a tick. 
 
1. Which paper size is normally used to print a document? 

a. A5 b. Legal c. A4✓ d. Letter 
 

2. Which one of the following is Microsoft Word document page orientation. 
a. Page Border b. Portrait✓ c. Margin d. Print Layout 

 
3. Choose from the following, what is Gutter margin in a Microsoft Word document? 

a. Margin that is added to the left margin when printing 
b. Margin that is added to right margin when printing 
c. Margin that is added to the binding side of page when printing✓ 
d. Margin that is added to the outside of the page when printing 

 
4. By default, on which page header or the footer is printed? 

a. On first page b. On alternate page 
c. On every page✓ d. None of the above 
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5. Portrait and landscape are 
a. Page Orientation✓ b. Paper Size c. Margin d. Print Layout 

 
6. Change the ________ to create Microsoft Word document in wide format: 

a. Page Orientation✓ b. Page Margins c. Paper Style d. Paper Source 
 

7. Which of the following do you use to change page margin? 
a. Formatting tool b. Page setup dialog box✓ 
c. Standard toolbar d. Paragraph dialog box 

 
8. ________ is not a type of page margin. 

a. Right b. Center✓ c. Left d. Top 
 

9. What is the blank space outside the printing area on a page? 
a. Clipart b. Margin✓ c. Header d. Footer 

 
10. Which of the following is type of page orientation? 

a. Landscape✓ b. Margin c. Both a and b d. None of these 
 

11. Which of the following is true regarding page orientation of a document? 
a. Page Orientation can be changed at any time✓ 
b. Page Orientation of document determines by printer 
c. Page Orientation must be set before start typing 
d. Page Orientation of a document cannot be changed. 

 
12. Switching between portrait and landscape mode involves 

a. Header and Footer toolbar✓ b. Print layout view 
c. Page setup dialog box d. None of the above 

 
13. The space left between the margin and the start of a paragraph is called 

a. Spacing b. Gutter c. Indentation✓ d. Alignment 
 

14. We can insert a page number at 
a. Header b. Footer c. Both b and c✓ d. None of these 

 
15. Which of the following is required to add different headers or footers to different parts of a 

document? 
a. Page breaks at the end of each page. 
b. Section breaks, Next Page. ✓ 
c. Alignment tabs. 
d. All the above. 

 
16. Which of the following items cannot be inserted into a Header or Footer of a document? 

a. Automatic page numbers. 
b. Tables with columns and rows. 
c. Pictures, shapes, and clipart. 
d. All the above items can be inserted into either a Header or a Footer. ✓ 

 
17. Which of the following content can you insert in a header or footer region of a document? 

a. A table, borders, and shading. 
b. An image, logo, or shape. 
c. The name of the document and its author. 
d. All the above. ✓ 
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18. John wants to insert the words: “American History” at the top of every page of his 83-page essay.  
Which of the following is the EASIEST method for him to do this? 
a. He can type the words “American History” onto the first page of the document and then copy and 

paste it onto all the other pages. 
b. He can type the words “American History” onto the first page of the document and click on the 

Header button to repeat it on all the other pages. 
c. He can type the words “American History” onto the first page after selecting the Header region 

of the document by clicking the top edge of the page. It will automatically be repeated in all 
subsequent header regions of the document. ✓ 

d. None of the above options are correct. 
 

19. If you have to write a college paper where the margins need to be set to the following exact 
measurements:  Left:  1.5″, Right: 4″, Bottom: 1″, Top: 1″, how could you go about setting this up? 
a. Launch the Page Setup dialogue box from the Page Setup Group.  In the Margins section enter 

the page margin values as noted in the question above.  Press OK. ✓ 
b. Click on the Margins button in the Page Setup group.  Select a preset margin option that matches 

the margin values as noted in the question above. 
c. Launch the Page Setup dialogue box from the Page Setup Group.  In the Paper size section enter 

the page margin values as noted in the question above.  Press OK. 
d. None of the above options are correct as they all contain errors. 
 

20. Which of the following describes a method for deleting a Footer from a document? 
a. Double click the footer region and delete all the content in the Footer. 
b. Click on the Insert tab on the Ribbon, click the Footer button and select Remove Footer from the 

list. 
c. Double click the footer region.  Under the Design tab in the Header & Footer group, click on the 

Footer button and select Remove Footer from the list. 
d. All the above are methods for deleting a Footer from a document. ✓ 

 
21. Study the screenshot below which represents a page in a Word document.  The page type used is 

ideal for content that needs to fit a wider page and is often used for tables, posters, and diagrams. 
   

 
 
What is this page setup called and how do you change a page to look like it (choose the most correct 
answer): 
a. It is called A4, click on the Size button in the Page Setup group to change the paper size. 
b. It is called Landscape, click on the Orientation button in the Page Setup group to change the 

orientation. ✓ 
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c. It is called Narrow, click on the Margins button in the Page Setup group to change the margins. 
d. It is called A3, click on the Size button in the Page Setup group to change the paper size. 

 
22. Study the screenshot below.   

 

 
 
 
How do you exit the header and continue working in the body of the document? 
a. Double click on the body of the document or click the Close Header and Footer button. ✓ 
b. Press the Tab key on your keyboard. 
c. Press Ctrl+c shortcut combination on your keyboard. 
d. Click back in the body of the document and start typing. 

 
23. What is the difference between Paper Size and Page Margins in Word? 

a. There is no difference, both are presets for how much content you can fit on a page. 
b. Paper size refers to the outside area of the page that can be made bigger or smaller to fit 

content.  Page Margins are the areas of the document where text is aligned. 
c. Paper Size refers to the size of the paper you will be printing your document on. Page Margins 

refer to the outside area of a page that can be made bigger or smaller to fit content. ✓ 
d. Paper Size refers to the orientation of the page, for example landscape or portrait.  Page Margins 

refer to the outside area of a page that can be made bigger or smaller to fit content. 
 
24. Study the screenshot below.   
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Sally wishes to create an A3 poster on Driving Safety for her students.  Which button(s) in the Page 
Setup group (pictured above) should she press to achieve this? 
a. She can press the Margins button and change the margins to A3. 
b. She can press the Orientation button and change the orientation to A3. 
c. She can press the Size button and change the orientation to A3. ✓ 
d. All the above options are correct. 

 
25. Which of the following is a very important step to ensure your page margins are not too narrow? 

a. Always preview your document or print a test page first to ensure the margins are not too 
narrow. ✓ 

b. Zoom out of your document to ascertain how close to the edges of the document your text is. 
c. You do not have to ensure that margins are correct, Word will warn you if they are not. 
d. In the Page Setup dialogue box, ensure that margins are not set to less than 1″ for top, bottom 

 
26. Study the screenshot below.   

 

 
 
How can you access the footer region of a document? 
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e. By pressing enter repeatedly after the last paragraph of a document. 
a. By going to the References tab on the Ribbon and selecting Insert Footnote. 
b. By going to the ‘Home’ tab and selecting a Border from the paragraph group to indicate where 

the footer must start. 
c. By double-clicking the footer region at the bottom of the page or right-clicking it and selecting 

Edit Footer. ✓ 
 
27. Study the screenshot below.   

 

 
 
What is the purpose of the Link to Previous function (circled in orange)? 
a. If selected, it will link the selected header or footer of one section of the document to the 

previous section. ✓ 
b. It links the header and footer of a document so that they will contain the same content. 
c. It links different pages in a document together to ensure they print correctly. 
d. It links different related documents together. 

 
28. Study the screenshot below paying attention to the section circled in orange.   

 

 
 



 
 

Documented by: Ashrya Soni 9 

How can you insert a date and time field that automatically updates every time the document is 
opened? 
a. Type the date and time manually into the header or footer section. 
b. Insert a Date and Time field into the header or footer section. ✓ 
c. Press Ctrl + ; (semicolon) to insert the current date and time into the selected header or footer. 
d. All the options listed above are correct. 

 
29. Study the screenshot below.   

 

 
 
How do you view section or page breaks (as circled in orange above) in a document? 
a. All page breaks and section breaks are automatically visible in a document. 
b. Double click the header or footer region and the page and section breaks will become visible. 
c. Press Ctrl+* to show all the page and section breaks in a document. ✓ 
d. None of the options listed above are correct. 

 
30. How can you increase the space a header takes up in a document? 

a. By increasing the value of the Header from Top option as required. 
b. By dragging the top margin downwards on the vertical ruler on the left-hand side of the 

document. 
c. By launching the Page Setup dialog box from the Page Setup group and increasing the By Edge, 

Header value. 
d. All the options listed above are correct. ✓ 

 
31. How do you remove any header or footer content, such as page numbers or document names, from 

the cover page (first page) of a document? 
a. Double-click the header and/or footer sections and delete any content on the first page of the 

document. 
b. Double click the header and/or footer sections and select the Remove Header and/or Remove 

Footer options in the Header & Footer group. 
c. Double-click the header and/or footer sections and tick the Different First Page box in the 

Options group. ✓ 
d. None of the options listed above are correct. 


